Tutorial 4: multiple gene expression tables

Starting from a list of gene
IDs with optional expression
values

Starting from a single count
table (RNAseq) or intensity
table (microarray)
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Starting with a network file
(sif, graphml, json)

Raw RNA-seq Data

Starting with several gene
expression tables for meta-
analysis

Uploading RNAseq fastq files
to our Galaxy server for
mapping & quantification
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Intro to NetworkAnalyst

* Web application that enables complex
meta-analysis and visualization

* Designed to be accessible to biologists rather

than specialized bioinformaticians m ﬁ
* Integrates advanced statistical methods and '-.--"’N't{m

. . . . . e
innovative data visualization to support: <€

e Efficient data comparisons

* Biological interpretation

* Hypothesis generation m/

M lt pl Gen
Gene List Input nTa bl es

Starting with a network file
(sif, graphml, json)

NetworkAnalyst -- a web-based platform for gene expression profiling & biological network analysis
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Computer and browser requirements

* A modern web browser with Java Script enabled
e Supported browsers include Chrome, Safari, Firefox, and Internet Explorer 9+

* For best performance and visualization, use:
* Latest version of Google Chrome
* A computer with at least 4GB of physical RAM
* A 15-inch screen or bigger (larger is better)

 Browser must be WebGL enabled for 3D network visualization
* 50MB limit for data upload

* ~300 samples for gene expression data with 20 000 genes



Goals for this tutorial

* A meta-analysis is a quantitative synthesis of results from multiple
studies that test similar hypotheses

* Gene expression meta-analyses aim to identify robust molecular
signatures and functional enrichment results to increase
understanding of biological processes

* Requires advanced statistics and visualization strategies

* The goal of this tutorial is to complete a meta-analysis of expression
profiles from 3 different studies:

* Perform and combine statistical tests
* Visualize results in interactive heatmaps, Venn diagrams, and 3D PCA plots



Appropriate datasets

* The two main steps of a meta-analysis are:

e Systematic literature review to identify studies that test the same hypothesis
* Rigorous statistical analysis of the datasets using established methods

* NetworkAnalyst provides a platform for the second step

* For the meta-analysis to be a success, appropriate datasets should be
used:

e Study designs should compare the same experimental factors

* Gene expression platforms should be comparable (i.e. studies should not be
spread over > 10 years)

» Relative similarity of host factors (i.e. species, tissue, sex, age etc.)



- Annotate Experiments

p I O a d d ata . Chmacond{t‘on: onlynece You Can edit meta_data
l , « Group labels: Edit group labels|
ety Ll labels here

« Samples with group label: To d
the corresponding whole row.

The first step is to upload and
process all of your individual

datasets. This repeats the steps of — Bosie Poskin -
etalLoadView.xhtml o i gfen;fy:em

a single gene expression table for

'QES-M1-LT Medium
QE5-M2-LT Medium

each dataset - for more details on alyst -- a web-based platform for gene expression pyfiling & biolo QESMILT  Medium
o Samples with group label gggmg mg:ﬁ:

each step, see tutorial 3. PFAG O Tutoris ot

QE1-52-LT Control

QE1-S3-LT Control

ata set. The maximum total number of samples allowed is 1000. When all data sets have been processed,

Iﬁ Use the panel below to upload and prepare each individual data

Click the individual cell to activate each process. Click Add New to add a ne,

Upload Data
Quality Check

Click Proceed to proceed. Click the Try our example if you want to us: ample datasets to explore the functions available.

SR Check QA/QC plots
o before and after
i i normalization

Meta-Analysis Data Upload ID Conversion Annotatj Visualization Normalization DE Analysis Data

x /# Process

Add New

= Data Formats

Make sure you have read the instructions before uploading your datasets. The maximum file
size per upload is 50M. Data can be uploaded as a tab-delimited text file (.txt) or its
compressed format (.zip).

[ Choose File = No file chosen ] Submit l i ‘
——————
== Data Processing . l T
The purpose is to convert gene/probe IDs to a common ID format (Entrez ID), so that %_ I 1
different data sets can be be properly compared. There are 47 built-in microarray probe 1D E l
libraries for human, mouse, and rat. For other IDs or organisms, make sure all datasets have w o e
the same ID type. I e
’ Specify organism C. japonica (japanese quail) - 8 -
If you don’t have supported IDs, —— L
) . Gene ID or Probe platform: Entrez ID - l s
ensure the same annotation is used = o P
' OK 1D Converston: Total [ 20165 ] Matched [ 16024 ] Unmatched [ 4141 ]
T T T
across all datasets and leave the . : o0 e
o
o HY o ”
second box “unspecified . o o
Done
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U | O a d d ata I
The table below summarizes the result from the previous data preparation steps. If

there are more than two conditions in the study, please decide which two conditions
are to be compared in the subsequent meta-analyses.

Number of annotated genes: 20165
[} NetworkAnalyst X ER Number of available samples: 10
¢ c & https://www.networkanalyst.ca/faces/uploads/MetaLoadView.xhtml tEsing valtes: $2(0.0%)
Normalization procedures used: Log2-counts per mitlon
Number of DE genes: 167
NetworkAnalyst -- a web-based platform for gene expression profiling & Set order of comparison: versus Treatment | ~
# Home ? FAQs Done g

= DE Analysis

- : 3 anel below to upload and prepare each individual data
This dialog allows users to perform differential expression analysis on individual data

set. The cut-off p-values are adjusted using the Benjamini-Hochberg's False Discovery

dividual cell to activate each process. Click Add New to add a new data set. The maximum total number of samples allowed is 1000. When all data sets e been processed,

Rate (FDR). d to proceed. Click the Try our example if you want to use example datasets to explore the functions available.
Contrasts sontrol v JE] Treatment 2 Upload ID Conversion Annotation Visualization Normallzation,_' DE Analysis Data Sumgfary Include
z‘ejtopﬁvalue (FDR) 0.05 A Piocess : \ ’ v 8
Add New Try our example Upload merged data

W sig[167)
Bl Non-Sig [15856)

= Data Normalization

Expression values should be compared at log scales with identical distribution across different h q f
arrays. You can use boxplots (available in the previous step - data visualization plots) to help Re p e at t I S p ro C e S S r

determine if the data is already on log scale.

additional datasets

For microarray data, the well-established variance stablizing normalization (VSN) in combination

M a ke S u re t h e - with quantile normalization can be used. For RNA-seq data, the log2-count procedure will
transform counts to log2-counts per million, estimate the mean-variance relationship and then
contrasts compare the

use this to compute appropriate observational-level weights in the later differential analysis.

same factors for all
uploaded datasets

Data Type RNA-seq data (counts) v

[Logz-counts per millon '

Perform auto-scaling

&3 © Proceed
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Select example data

[ NetworkAnalyst X

c

< & https://www.networkanalyst.ca/NetworkAnalyst/faces/uploads/Metal.oadView.xhtm| * 0+ BR @ @

For the rest of this tutorial, we
will use the example data Click “Try our example”
and “Yes”

Example Datasets

Datasets Data Type Phenotype

© testing datasets (containing
subset of 5000 genes) from a meta- CONTROL
analysis of helminth infections in mouse  INFECTED
liver (details)

E-GEOD-25713 Illumina MouseWG-6 v2.0 Bead Array;
E-GEOD-59276 Illumina MouseRef-8 v2.0 Beaggfo
GSE69588 Affymetrix Mouse Gege#®.0 ST Array;

Click “Proceed”



View integrity check results

For a meta-analysis to be done properly, the individual _
analyses must test contrasts between the same factors. * O+*BEO @
The integrity check ensures that the labels are
consistent for all previous analytical steps.

= Integrity Check Result

OK, all datasets passed intergrity check. Click Next button to next page.
You can download the merged data here: & Download

Cancel m

Click “Next” and
“Proceed”




View raw data and correct batch effect

[ NetworkAnalyst X -
&« C & https://www.networkanalyst.ca/NetworkAnalyst/faces/Secure/metastat/MetaQCView.
- .
Bty ,5. e
M i | .
P 'y NetworkAnalyst -- network-based visual ang
e
. 4

Adjust study batch effect (Combat) «

(0]

Upload Data
Quality Check
Meta-Analysis

Sig. Genes

PCA plot Density plot

Use the PCA and density plots to check the
guality of the data. Here we see significant batch

effect, so select Combat and click “Update”.

Analysis Overview Conditions
» Network Analysis CONTROL
z:iwnload ) . g 0- p INFECTED
t Y 8 =
B N Datasets
S a @ E-GEOD-25713tmt
Conditions A E-GEOD-59276 10t
CONTROL
7 INFECTED B GSESSES 1e
n 2 .20
E o Datasets
8 ® E-GEOD-25713.1a
- A E-GEOD-59276 tat
B GSE60588.txt
. 40« . I 40-
After applying Combat, 5 ; .
PC1(52.1%)
the study batch effect has
200 0 200 100
been greatly reduced! PC1 (675%
= < Click “Proceed”
Proceed

© Previous
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Conduct gene-level meta-analysis

NetworkAnalyst has four approaches for gene-level
c c . |
meta-analysis. The first two are recommended, while the R
second two (vote counting and direct merging) should be 1
c r gene expression profiling, inte
used for exploratory purposes only. Since we have many 1 | ’
5 . h Home ? FAQs O Tutorials & Gallery o = w
DEGs, we choose to combine based on effect sizes. 3
w
Ptween two group means divide: standard deyias@® which are considered combinable and comparable across é w -
From the Q_Q pIOt We See that the data xed and ramgdompeffec ' g db a::R:M). In FEM, the estimated :fec?size::leabclh stu‘:Jy 15:;su:ed to com
deviates substantially from the straight  comiiSnissmmosissbas e B
line, so select REM. v v ¥ T v 71
0 2 4 6 8 10 12 14
[Random Effect Model ' - -
Cochran’s Q Tests Submit Quantiles of Chi > square
Set a significance level [ Fixed Effect Model J
Random Effect Model ( : >

Vote Counting

Here we will base the meta-analysis on
o cffect sizes. To choose between a FEM KSR
and REM, generate a Q-Q plot by clicking [t

“Cochran’s Q Tests”. @

gene can then be calc

Click “Proceed”

Set a significance le:

© Previous
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View results of meta-analysis

Expression Pattern

Download

Exit

Note, expression values have been scaled to facilitate cross-study comparisons.

» Network Analysis

Rnaseé
E-GEOD-25 (n=24) | E-GEOD-59 (n=5) | GSE69588 (n=9)
- =2 B es/Secure/metastat/MetaResultView.xhtm| * 9 * B ® &
e e
. 3 > 3 : - . A .
o ‘ ‘ | ork-based visual analytics for gene expression profiling, integration & systems understanding
-3 Resources & Contact 2 Account v
The results can be sorted
-1 = p— J =
s —E ult before being downloaded
\\“10 (.«’0 ‘\‘“o (—_‘-«p o\\‘“ eﬁ‘%o nalysis are given in columns with the co a S a . CSV fl I e . image icon in the View
0 \ <© N < \¢ ary of the corresponding genes across d . The complete result
Datasets Download button below.

Sort
4 Sorting
e (l0gFC) &  table Pval | Ascending & Update £ Search 4+ Download
order:
by:

E-GEOD-25713

Click on the picture icon
to see a boxplot of a

1.6814

K23 -2.5724
Gt 07015 specific gene across
N . datasets
Csfarb2 1.9952
sle22a5 -0.71141
Cel19 0.94445
Cd4a 0.79847
Ikzf1 0.77847
Pirati 1.3282
Fkbp11 0.88198
[+] Previous -
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We now want to further analyze and visualize the

results of the statistical analysis. There are 4 datasets An a |ys I S Ove rVI eW

to work with: the 3 individual datasets and their

significant genes, and the combined statistics from the

. ue: N
meta-analysis. The “Sig. Gene Analysis” tools are e Y o+EHO @ :
based on the 4 lists of significant genes. The “Global
Analysis” tools use the matrix of combined statistics lytics for gene expression g

from the meta-analysis for GSEA tools and all gene eIl  Sce tutorial 2b for more details on how to
expression data for PCA 3D. use Venn and Chord Diagrams to compare
Upload Data Visual analytics technology aims to integrate interactive visualization with statistical analysis to help navigate col the overlap Of mUItiple gene “Sts
SRR experience, you need to have a modern web browser with sufficient memory available. We recommend using: a) !

Firefox; b) at least 15-inch display with 1440 x 900 resolution or higher; ¢) at least 2G available memory with Intel Core i5/i7 or equivalent;

Data available:
E-GEOD-25713 (2963)

E-GEOD-59276 (2878)
GSE69588 (33) ‘_> Network Visual Analytics

Genes from meta-analysis (2022)

ORA Enrichment Network
Note: you need to perform gene-level

meta-analysis to select Genes from meta-
analysis option. . Sig. Gene Analysis t ORA Heatmap Clustering

Cancel 0K Venn Diagram

Chord Diagram

GSEA Enrichment Network

— Global Analysis GSEA Heatmap Clustering

Network Visual Analytics can only be
performed on a single list at a time.

PCA 3D

See tutorial 2a and 5 for more details
on creating networks.
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The ORA heatmaps are interactive, allowing users to easily I .
visualize, perform enrichment analysis, and define gene O RA H eatm a p C u Ste rl ng

signatures using groups of genes from the heatmap.

Perform enrichment analysis
on the genes in the focus view

[ NetworkAnalyst X -+

< & https://www.networkanalyst.ca/faces/Secure/vis/HeatmapView.xhtm| bxg

C

k » Meta-Analysis » Sig. Features » Analysis Overview » Sig. Sets View » PCA 3D » Heatmap Clustering # Home ? FAQs () Tutorials B Updates B Resources = CO

By CI u Ste rl n g t h e ge n es green-black-red BB()rdcr: None a Cluster genes:  Average linkage B(Thmcr samples:  Average linkage B Download: --Please Select-- Y Builder ' @
and samples, we see that Earichment Aniyis -

: Query:_Genes in Focus view |
there are clear differences T
between the infected and et El L
ntrol ross all three : . el
contro Zac Click “Builder” to construct T
ata Sets . a C u Sto m h e at m a p f precursor metabolites a 0.00157
Select a group of genes with a
distinct expression pattern in e

the overview by dragging your ! —_—
mouse. They will appearin
the focus VieW' @ McGill (last updated 2018-12-14) —




Enrichment networks help interpretation of O RA E N riCh me nt N EtWO rk

enrichment analysis results since sets with a
significant number of overlapping genes are

connected with an edge, grouping functionally
similar sets together. Here, ORA can be performed
on any subset of the three gene lists.

nrichment.xhtm| w o * B ® ‘ :

# Home ? FAQs (% Tutorials & Gallery # Updates & Resources &) Contact 2 Account «

Network  Global EnrichNet 1 fiew: Gene-set network Fe Layout: Specify -- B Scope:  Single node a Download: Specify B

Enrichment analysis Result Table

Dgtabase: KEGG * Extract selected functions
v KEGG Obper Union B Intersection = :Il : o
Reactome Target:  E-GEOD-25713.txt v Union -
Metabolism W xenobiotic A
GO:BP ins M\ You can view gene sets of
GO:MF E-GEOD-25713 1xt 2956 IR 5
GO:CC interest separately from
: GSE69588.txt 8
i::::ggs; the rest of the network by
. Propanoate metabolism
PANTHER:CC i, ok e selecting their name and
Motif Search Steroid biosynthesis . .
Farty acid metabolism CI IC kI ng IlEXt ra Ct”
Union (3 datalists) /A N ) i Systemic lupus erythemar 13/

Citrate cycle (TCA cycle) 1931 0.00834 0.151

Gene set nodes are coloured RN Glutathione metabolism 2850 000876 0.151

Leishmaniasis 27/48 000922 0.151

based on their enrichment /] Pymvate meubolism 2442 00107 0156

Malaria 9/12 00114 0.156
p-value. Gene nodes are Sphylococcus mureus i 2238 00I17 10156
Cytosolic DNA-sensing p 13720 00147 0.18

coloured based on the " poe

74 00161 0.18

combined statistic from the Double-clicking a gene set
meta-analysis. meta-node expands the view

of nodes for the significant
genes that are part of that set

00152 0.18
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GSEA for meta-analysis

* A computational method for determining if the expression of a set of genes
(biological pathways, etc.) is correlated with phenotypic differences between
sample groups

* Incorporates actual gene expression data and so it is able to detect more
sensitive differences than simple ORA

* Always requires input genes to be ranked somehow — here the meta-analysis
results are used as the ranking metric

e GSEA results using meta-analysis statistics can be thought of as a “gene set-
level meta-analysis”

e Refer to the original paper for more details on GSEA:
e https://www.pnas.org/content/102/43/15545.short



https://www.pnas.org/content/102/43/15545.short

Colors: navy-white-firebrick Bordcr: Yes

GSEA is performed using the meta-
analysis results to rank the genes. The

GSEA heatmap tool allows users to

generate a heatmap of expression across

datasets for any enriched pathway.

o) oo

Clustering:  Genes

2 ] O
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18 Enrichment Score: 0.4611248
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Enrichment Analysis G Save
Database:  KEGG Submit EJ Save
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Osteoclast differentiation 59/110 1.333397¢-2 2.359086¢-2
Serotonergic synapse 19/90 1.333397¢-2 2.359086¢-2
Butanoate metabolism 16725 1.333397¢-2 2.359086¢-2
Retinol metabolism 40/80 1.507143¢-2 2.47602¢-2
Cell adhesion molecules (CAM 57/136 2.115076e-2 2.774919¢-2
Leishmaniasis 30/48 2.115076e-2 2.774919e-2
Tryptophan metabolism 24/41 2.171676¢-2 2.774919¢-2
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GSEA Heatmap Clustering

Clus'tcring methods:  Euclidean Cluslcr linkage: Average

# Home ? FAQs

Click “Download” to
generate a high quality

PNG or SVG image of

the heatmap
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Since GSEA is performed using the meta- G S EA E n ri Ch m e nt N etWO r

analysis results only, set operations
between different datasets are not enabled.
« . T — ” Change to “Bipartite network” |CHEZ
S p— ey [ /€W the individual shared S
genes between gene sets

Enrichment analysis
Database: GO:MF

Operation:

.\'JI"]L' e
|

Nucleotide bindigh

Name

Actin binding ‘
meta_data

Antigen binding ‘
Carboxylesterase
Glutathione tran
Monooxysg

Current gene list
Ribonucle

Search Phospholipase C
|
Transmembranc

Union (1 datalists) e |
Serotonin recepiq

® |
Receptor binding
Genes not shown for large lists,
Click on a gene set node to sec corresponding

genes

Cytokine activity ‘
Inward rectifier
Volt:

Lipid transporter
Organic acid tra
Glycosaminogly
Chemokine activ

Monocarboxylic

Current selection (n

@
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Dimension reduction

* 0O+ BEO @O

My Account =

) NetworkAnalyst X -+
& (¢ @® https://www.networkanalyst.ca/faces/Secure/vis/PCA3DView.xhtml
# » Upload Data » Quality Check » Meta-Analysis » Sig. Features » Analysis Overview » Sig. Sets View » PCA 3D » Heatmap Clustering # Home ? FAQs 0 Tutorials W Updates ¥ Resources & Contact
PCA displa: v/ Based on all data (default) Download: --Please Select-- Number of genes shown: = . 1000 Update
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For more information, visit the FAQs, Tutorials, Resources,
and Contact pages on www.networkanalyst.ca



https://www.networkanalyst.ca/faces/home.xhtml

